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Useful Information about this User Guide

Useful Information about this User
Guide

Overview: About this User Guide

This section provides useful information about the User Guide. This section
provides answers to several questions concerning this User Guide.

Questions About the User Guide

Before reading the User Guide, you may have some questions. In this section
we answer several questions about the User Guide.

Who is the User Guide intended for?

This User Guide is intended for users wishing to use the C3000 in conjunction
with Lotus Notes. It doesn't matter whether you use the User Guide in printed
form or online.

What information is available in the User Guide?

This User Guide contains information required to work with C3000 for Lotus
Notes as a user.

What information is not in the User Guide?

This User Guide does not contain any information about connecting C3000 to
telecommunication systems or configuration of ISDN cards.

This User Guide does not contain any information about installation, configu-
ration or administration of C3000.

This User Guide does not contain any information about the telephone user
interface (TUI).

How is the User Guide structured?

This User Guide describes how to use C3000 for Lotus Notes.

Which issue of the User Guide is this?

The following table contains information about this issue of the User Guide.
Explanation

Created on 19.11.08

Basis C3000 Rel. 1.7 SP2
Author Claudia Handel

Available as PDF (Acrobat Reader) file
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What has changed?

The following table shows the history of this document.
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1.6
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Change

Printer driver: New dither method: "C3000 fax printer" section on
Page 26

TUI diagram 3: Private message
Corrections and revisions
Revision of printer driver descriptions:

Lotus Notes: "C3000 mail merge, for example using MS Word"
section on Page 29

Notes printer: Update of "Operation" section on Page 23

New section: "OCR (automatic text recognition)" section on
Page 33

New section: "SMTP Transmission with Pegasus Mail" section
on Page 36

"Fax-on-demand" section on Page 35
Notes on RTF format: "Fax-on-demand" section on Page 35

In the whole manual: Diesis (double dagger) replaced by hash
symbol.

Corrections and revisions
Title sheet: New AVAYA TENOVIS logo

Telephone menu setup: "User tab - TUI configuration tab" section
on Page 13

Selecting languages for the TUI: "User tab - TUI configuration
tab" section on Page 13

Language control for the TUI: "User tab - TUI configuration tab"
section on Page 13

Topic removed: Using the TUI
Topic removed: TUI flowcharts

New topic: "Where can you find more information?" section on
Page 6

Additions to the index: "Index" on Page 42

Digital signature: New check box in C3000 message for sending
faxes: "With C3000 Lotus Notes client add-on" on Page 21

New topic: "C3000 network printer" section on page 40

New topic: "Send e-mail, fax or SMS via UMS address book"
section on Page 23

Telephone menu setup: "User tab - TUI configuration tab" section
on Page 13

New topic: "Wav-to-Phone" section: "Switch forwards and back-
wards in messages" on Page 24

Network Printer
Title sheet: AVAYA logo, C3000 Fax Printer
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Where can you find more information?

Additional information on the UMS is available in the following manuals:
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C3000 Installation Manual (installation, configuring ISDN cards, connec-
ting to telecommunication systems)

C3000 Administrator Manual

C3000 TUI User Manual

TTrace Installation and Configuration Manual
TTraceConsole Instruction Manual



Introduction

Introduction

Unified Messaging for Lotus Notes

Unified Messaging

In all communications processes, company employees are supported by
modern technologies which at present still utilize different media: Voice mail,
e-mail, fax and SMS text messaging. For the employees this means they must
use and constantly check a variety of different, separate inboxes for mes-
sages. For the company this means several separate systems are operated
and administered alongside each other in an expensive and time-consuming
way. Consolidating all information channels onto one single user interface
makes employees' workflows much more efficient and cuts out redundant
administration processes: Unified Messaging System (for short: UMS).

Communication without Media Breaks

UMS provides users with centralized access to all messages in a mailbox.
Whether phone calls, faxes, emails or SMS text messages; all information can
be received, edited and sent using a unified user interface. In this way, Unified
Messaging ensures that no messages are lost and that recipients are always
reached promptly. The information is easily accessed using your familiar eve-
ryday work system: Lotus Notes. This means you can reorganise all commu-
nication processes to be more user-friendly and to react more quickly, without
any additional training. Highly cost-effective in every way: Unified Messaging
will bring your company significant cost savings and therefore ensure a faster
return on investment. Harmonizing all communications services under a single
user interface such as Lotus Notes and using the personalised UMS voice
mailbox means it is no longer necessary to use separate hardware compon-
ents such as fax machines and telephones.

The add-ons include:

FAX

Send your faxes like emails, including file attachments such as Microsoft
Office documents.

Receive faxes with Lotus Notes and view them on-screen.

SMS

User-friendly text messaging with the UMS SMS form.
Receive SMS text messages in your inbox just like e-mails.

VOICE

Messages from your personalized voice mailbox are sent to your inbox. This
means that, as well as checking your messages in the normal way over the
telephone, you can also double-click on them in Lotus Notes to listen to them
on your PC or open an Action menu to forward them to your extension (Wav-
To-Phone). You can use the phone keypad to skip forwards and backwards in
the messages.
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Introduction

Forward received voice mail messages to any telephone number.

FAX printer

Generate fax documents from any application and send them using Lotus
Notes. Create broadcast circulars (mass faxes/fax broadcasting) using the
mail-merge/print-merge function of Microsoft Word or other programs and
send them using the UMS.

Optional services

In addition to the standard services (FAX, SMS, VOICE), other services such
as text recognition modules (OCR) or archiving systems can also be added.
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Configuring Your Own User Data

Configuring Your Own User Data

Your system administrator can assign you rights enabling you to configure
your own user data using WebAdmin. This chapter describes the settings you
can make. Settings you are not authorized to change are greyed-out in Web-
Admin. You can read the settings, but you cannot change them yourself.

Signing on to WebAdmin

Field

Field

Field

Enter the name of the C3000 server in the web browser. You can get this from
your system administrator.

A login website is displayed.

You will need to make the following entries to log in. Ask your system adminis-
trator for the relevant data.

Server address

Enter the name of the C3000 server.

Name

Enter the full login name you received from your system administrator.
Password

Enter the password you were assigned by your system administrator.
You can also set the language for the web interface.

Click on the Login button.
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Tab control overview

Once you have successfully logged onto WebAdmin you will see the following
tabs:

Click on the User tab to view the following tabs:

* General (Address data)

» C3000 General (Location/Fax layout)

* Routing rules

* TUI configuration

* TUI announcements/greetings

Click on the Documents tab to view the following tabs:
» Filter settings
* Display options

Note Greyed-out fields signify: your system administrator has not
assigned you the necessary rights to edit this data. You can
change the other fields that are not greyed-out. Contact your
system administrator for more information.

User tab

The user information is spread across the following tabs:
* General (address data)

» C3000 General (Location/Fax layout)

* Routing rules

* TUI configuration

* TUI announcements/greetings

User tab - General tab
System button > User tab - General tab

Here you can change general address data.

Note You can only change values in the grey fields if your system
administrator has configured local user management and
assigned you the relevant user rights.
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Selection field

Selection fields

Field

Example

Field

User tab - C3000 general tab

System button > User tab > C3000 General tab

Location

Here you enter your location.

Cover sheet, Writing paper first page, Writing paper additional pages:
Here you select your fax layout settings for the user concerned.
Signature file (TIFF)

Ask your system administrator whether they have set up a signature file for
you.

Note Optimum signature display is achieved with the following
values:

* Resolution: 96 dpi
+ Height: approximately 150 pixels
»  Colour intensity: 1 bit (2 colours).

If signature file has not yet been set up, a message underneath the field points
this out.

Complete the following steps to assign yourself a new signature file:
1. Click on Browse.
2. Select a previously generated signature file and click on Open.

The selected signature file is linked to your name and uploaded to the
C3000 server.

The signature files are accepted by the C3000 server, provided they are in
TIFF format.

Note One signature file only can be stored for each user.

Note TIFF is a commonly used graphics file format which can be
created and edited by many graphics and scanner programs.

SIGNATURE_RIGA.TIF

Signature name for the digital signature

Do not make any entries here. Your system administrator completes this field
for you.
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Field

Field

Checkbox

Selection field

User tab - Routing rules tab

Routing rules are usually set up by your system administrator.

User tab - TUI configuration tab
System button >User tab > TUI configuration tab

This is where you configure the TUI (Telephone User Interface | Voice box).
Fax output number

The fax number entered here is used if you want to forward incoming faxes
using the TUI.

Note Fax number rules: no blank spaces, no special characters, +
sign prefixing country code permitted

Backup number

Before the caller is routed to the recording section of the personal voice mail-
box, they can decide whether to be put through to the backup (representa-
tive's) number entered here (call transfer).

The entry can also be made at the TUI.

The backup option is usually deactivated as the default value.

Note Only basic accesses (MSN) of the telephone system are sup-
ported. (Telephone system extensions do not have standard
call transfer functionality)

Telephone menu setup

If you, as a user, call up your new mailbox for the first time, the telephone
menu setup opens. The telephone menu setup helps you to set up your basic
mailbox.

If the check box for global telephone menu setup is activated in the net port
configuration of WebAdmin, telephone menu setup is activated for each user
who has not yet run through the telephone menu setup for their mailbox. A
successful run through is saved for the user

» Activate this checkbox so that you, as user, can run through the tele-
phone menu setup again.

« Deactivate this checkbox so that the telephone menu setup is no longer
available to you as a user after it has successfully been run through.

Default value: Activated

Languages

Here you can choose up to three languages for the TUI from six specified fixed
languages. You can then switch between the languages set here in the TUI.
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Checkbox

Checkbox

Field

Selection fields

* If no language is set here the language settings of the net port are used.

» If alanguage is set here (or two or three languages), then the net port
language settings no longer apply.

Complete the following steps to select a language:

1. Select a language from the selection field.

2. Click on Add.
— The language appears in the list below with the prefixed Recycle Bin
icon
— If there are already three languages in the list and you nevertheless
choose a fourth language, a message appears stating that max three
languages are supported.

— The first language in the list is automatically the default language of
the TUL.

3. Click on the Recycle Bin icon to remove a language from the list.

You can choose from the following languages:

« German
* English
* French

e ltalian

* Spanish
*  Flemish
*  Turkish

Language control
Activate this check box to switch on language control for the TUI.

Default value: Deactivated

Activate private messages

The C3000 TUI enables you to send personal spoken messages to external
parties. To do this, record the message on your voice mailbox and assign it a
PIN. External parties can dial in and listen to the message if they know the PIN.
Only one message at a time can be recorded and stored. Set this option by
activating the following checkboxes: Activate private messages.

PIN

Here you enter the PIN for the Private messages function.
Announcements/Greetings

Here you set the type of announcement for your voice mailbox.

C3000 differentiates between internal and external calls. External calls are in
turn differentiated by calls received during and outside normal business hours
and calls received on public holidays.

You can choose from the following types of announcements:

* Deactivated
No user-specific settings have yet been made. This is the system's
default setting. The announcement states that it is a voice info system
and gives the user's extension number.

*  With user name
The announcement is the same as for the Deactivated option, but a pre-
recorded user name is given instead of the extension number.
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Fields

Selection field

* User-defined or Announcement 0,1, 2...9
An individually recorded (personalised) announcement is played back.
Only one personalised announcement can be recorded for internal calls,
up to 10 different announcements can be recorded for external calls.

*  Without recording
An information announcement is played back only. The caller cannot
leave a message.

Message memory

You cannot change anything here. Your system administrator will enter these
settings for you.

Message memory

You cannot change anything here. Your system administrator will enter these
settings for you.

User tab - TUI announcements tab
System button >User tab > TUl announcements tab

Complete the following steps to assign wav files to the internal and external
announcements:

1. Click the relevant pencil icon 4 .
A field is displayed.
— Click Browse to select a wav file.

— Click  , to upload the selected wav file. The status-bar indicator
changes from blank to available. The wav file is not saved until you
click the Save button.

— Click on the red cross & , to cancel the current action.
Assign more wav files.
Click Save.

Note Ask your system administrator whether and where they have
stored wav files for you.

The wav file must be saved in A-Law 8-bit, mono 8 kHz for-
mat.

A-Law (or CCITT Standard G.711) is an audio compression
method commonly used in telephony applications.
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Option

Field

Field

Documents tab

The document information is spread across the following tabs:

* Filter settings

» Display options

Here is where you manage your documents. An extensive range of filter rules

are available for incoming and outgoing messages. The following actions are
available for the displayed documents:

¢« Delete
¢ Mark as read
¢ Forward

More detailed information is available in the "Edit displayed documents (inco-
ming)" chapter on Page 18.

Documents tab - Filter settings tab
System button >Documents tab > Filter settings tab
This tab is where you compile document filters.

You can use the filter settings to limit the number of documents found by spe-
cifying search criteria.

Here a distinction is made between general conditions (User, Folder, time
limits From and To) and the conditions dependent on the document type.

Click the Display button to send an inquiry.

An inquiry can only ever be submitted for one document type at a time. |.e.
incoming documents only or outgoing documents only.

The send requests are displayed for outgoing documents. The corresponding
documents can be identified by the displayed document ID.

Incoming/Outgoing

Here you select whether incoming or outgoing messages are filtered. The cor-
responding document status filters are evaluated depending on this setting.

Display hits

Limiting the displayed hits. If the inquiry returns more hits than indicated here,
a warning is issued that the inquiry returned n hits but only x of them are dis-
played.

Value range: 0 to 99999

Note Large values sometimes result in very long loading times. You
should therefore try to limit the results list.

User
Limits the inquiry to one specific C3000 user only.
A valid user ID must be entered here.

Example: name@xx.yy
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Field

Fields

Fields

Selection field

Range

Checkbox

Checkbox

Checkbox

Checkbox

Checkbox

Checkbox

Folder

Limits the inquiry so that only documents from a specific folder are displayed.
Example: *INBOX

Date: From / To

Limits the inquiry results to a specific period of time. A date is entered in these
fields. It is possible to make an entry in one of the two fields only, i.e. to specify
all documents before or after a specific date for example.

The From time is interpreted as 00:00:00 hours on the day in question if no
From time is specified.

The To time is interpreted as 23:59:59 hours if no To time is specified.
Format: dd.mm.yy or dd.mm.yyyy

Example: 24.12.2002

Time: From / To

Further narrows down the limitations resulting from the date (from/to). The
start and end times of the selection can be specified more precisely by ente-
ring the times. The times are only taken into consideration if the corresponding
date is also set. l.e., it is not possible to filter out all documents between 10:00
and 15:00 hours on any day.

It is possible to make an entry in one of the two fields only.
Format: hh:mm

Example: 12:15

Service

Select the service you want here (e.g. Fax/Voice/SMS). The Internal service
(C3000 address) refers to messages sent within C3000. Your system adminis-
trator can provide you with more information.

Incoming/Outgoing

Here you can select the status indicators. The corresponding document status
filters are evaluated depending on this setting.

Successful

The message has successfully been sent.
Failed

An error occurred when sending the message.
Waiting

The message has not yet been sent.

Active

The message is currently being sent.

Stopped

The transmission was aborted while waiting.
Authorize

The message must be authorized for sending.
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Checkbox

Checkbox

Checkbox

Field

Field

Button

In progress
The message is currently being processed. .
Tried

An attempt has already been made to send the message; further attempts are
pending.

Authorization refused

Authorization to send the message has been refused.

Document ID

Enter a known document ID to find a specific document.

Send request ID

Enter a known send request ID to find a specific transmitted document.
Clear filter

This deletes the set filter.

Documents tab - Display options tab
System button > Documents tab - Display options tab

Here is where you configure the attributes to be displayed, and the order in
which they are shown, separately for incoming and outgoing documents.

Activate the checkbox options you want and enter appropriate values in the
selection fields.

Click Display to view the results.

Editing displayed (incoming) documents

The following three edit functions are available for incoming documents: For-
ward, Mark as read, Delete.

» Complete the following steps to forward a displayed document to another
person:

Select the displayed document by activating the relevant checkbox.
2. Select Forward from the Action list box.

Note The forwarding function is only available if you are authorized
for the Internal (C3000 address) service.

Your system administrator can provide you with this right.

3. Inthe Destination (User) field, click the buttonJ, to select a C3000
user. Only C3000 addresses are possible here.

4. Click the Execute button.

The selected document is forwarded to the corresponding C3000 user.
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» Complete the following steps to mark a displayed document as read:
1. Select the displayed document by activating the relevant checkbox.
2. Inthe Action list box, select Mark as read.

3. Click the Execute button.

The selected document's status is set to Read.

» Complete the following steps to delete a displayed document:

1. Select the displayed document by activating the relevant checkbox.
2. Inthe Action list box, select Delete.

3. Click the Execute button.

The selected document is deleted.

Editing displayed (outgoing) documents

Note Queued send requests are automatically deleted after 24
hours and assigned the status Failed.

The following edit functions are available for outgoing documents: Delete, Re-
send, Forward, Stop.
» Complete the following steps to delete a displayed document:

1. Select the displayed document by activating the relevant checkbox.
2. Inthe Action list box, select Delete.
3. Click the Execute button.

The selected document is deleted.

* Complete the following steps to re-send a displayed document (failed
outgoing messages only):

1. Select the displayed document by activating the relevant checkbox.
2. Inthe Action list box, select Re-send.

3. Click the Execute button.

The selected document is re-sent.

»  Complete the following steps to forward a displayed document to another
person:

1. Select the displayed document by activating the relevant checkbox.

2. Select Forward in the Action list box.
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Note This forwarding function is only available if you are authorized
for the Internal (C3000 address) service.

Your system administrator can provide you with this right.

3. Inthe Destination (User) field, click the buttonJ to select a C3000
user. Only C3000 addresses are possible here.

4. Click the Execute button.
The selected document is forwarded to the corresponding C3000 user.

» Complete the following steps to stop a displayed document (queued out-
going messages only):

1. Select the displayed document by activating the relevant checkbox.
2. In the Action list box, select Stop.
3. Click the Execute button.

The selected document (outgoing send request) is stopped, i.e. its status
changes from Waiting to Stopped.

Reports via WebAdmin

You can have so-called reports emailed to you via WebAdmin. Further infor-
mation is available from your system administrator and in the C3000 Adminis-
trator Manual 1.7, in the Reporting: Scheduler section.
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Using C3000 for Lotus Notes

Temporary
addressing

Inbox window

Without C3000 Lotus Notes client add-on

The new functions without use of the client add-on are presented first.

The C3000 Lotus Notes Integration can generally be used without any client-
side installation being necessary. Incoming faxes and voice messages are
received in Lotus Notes like normal emails, in which the messages themselves
are attached (FAX as ™ tiff files and voice messages as *.wav files). The files
can then be viewed or played back using the appropriate image viewer or play-
back hardware.

Documents are sent using the standard memo form in Lotus Notes. Implicit
service selection (e.g. faxnumber@FAX, mobilenumber@SMS) in the
address field (To:) of the memo form enables users to use C3000 for Lotus
Notes.

Example: 0403888282@FAX

With C3000 Lotus Notes client add-on

Install the C3000 Lotus Notes client add-on to make the system more user- fri-
endly.

The C3000 Lotus Notes client add-on consists of a several components:

* C3000 Faxprinter

» C3000 Wav-To-Phone add-on (to play back wav files over the telephone
» Selection of cover pages and writing paper

If the administrator has extended your mail templates to include the additional

C3000 forms, views, sub-forms and agents from the c3kaddon.nsf file, further
folders/views and functions will be available.

Complete the following steps to bypass opening received emails by
double-clicking on the message and then double-clicking on the attach-
ments (C3000 view):

1. Select the C3000 Inbox view and click the Open button.

A window appears with a view of received faxes or an application (e.g.
Media Player) is started to play voice messages on your PC.

Two forms are available for addressing: C3000 Message and C3000
SMS.

2. Inthe Lotus Notes window, click on Create = C3000 Message or Cre-
ate >C3000 SMS.

3. Click the C3000 Temp Number button.
A window for temporary phone numbers/addresses appears.

4. Init you can enter a temporary address for a selected service and enter
additional information for an existing cover page.e.g.: Name and first
name of the recipient, street, postcode and town/city, and the company
name.

5. ClickOK.
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A window appears in which you can add further information. Your entries just
made then appear in the Recipient field, separated by the # symbol.

Example:

Temp@0403882882#C3000#John#Smith#AnyFirm#PersonnelDept#Any
Street 11#12345#AnyTown#FAX3@C3000

6. Click C3000 Options to assign a cover page or letterhead to the send
job.

The Options window appears.
Choose Cover sheet and Letterhead/ Letterhead p. 2.

Select a Send time and the Priority. Activate the Return Receipt
checkbox to request confirmation of receipt. You can also enter a Cost
centre.

9. Activate the Digital signature checkbox to digitally sign the fax.

10. If you have not selected a specific service in the temporary address (e.g.
faxnumber@c3000), an implicit service can be specified using this form
(Service selection box).

11. If you have made all the settings you want, click OK.

The message is then sent.

C3000 SMS

You can use the C3000 SMS to enter a mobile phone number and SMS text
in a separate window.

1. Click the Count characters button to specify the length of the SMS text
message.

A window appears in which the number of characters is displayed. Click
OK to close the window.

Click the C3000 SMS Options button.
The SMS Options window appears.

Select a send time (immediately or Date/Time), select the job priority
and enter the user's cost centre. Activate the Return Receipt checkbox
to request confirmation of receipt. Click OK.

Sent window In the C3000 Outbox view you can check whether the send jobs have been
successfully sent or not, and you can send them again.

1. In the Lotus Notes window, select the C3000 Outbox view in the direc-
tory tree and click on Actions=> C3000 = Check Sent Items.

The sent items are checked and entered with the relevant status in the
C3000 Return Receipt view.
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Send e-mail, fax or SMS via UMS address book

Instead of temporary addressing, you can also use the UMS address book for
addressing. This applies to emails, fax or SMS messages.

Complete the following steps:
1. In the Lotus Notes window, click on Create - C3000 Message.
2. Chick on the Address ¥button and then UMS.

The C3000 AddressDialog appears.

Select an address book and/or a sort order.

Select the required service:

Explanation

SmartService Message is automatically sent as an e-
mail, provided an e-mail address is
available.

If there is no e-mail address the mes-
sage is automatically sent as a FAX.

Mail Message is sent as an e-mail.
FAX Message is sent as a fax.
SMS Message is sent as a SMS.

5. Click the To button.
The Recipients selection window appears.
Select a recipient and click OK.
The correct address is automatically entered in the area below.

If required, click on Copy and/or Blind copy and enter a recipient for
each.

9. If the information about the user stored in the address book is appear on
the cover sheets (e.g. address), activate the checkbox Recipient info in
cover sheets.

10. Click OK.

The message is sent to the recipient(s) in the required form.

Operation

Wav-to-Phone

With UMS for Lotus Notes you can also receive voice messages (from your
personal voice mail) in the form of wav files (Windows format: CCITT A-Law,
8.00Khz, 8-bit, mono) in your Lotus Notes inbox. You can play them back
using the usual sound hardware. If you have no sound hardware on your PC,
the voice message can be forwarded to your telephone for playback. This is
why this option is known as Wav-to-Phone.

If the Wav-to-Phone add-on is installed, a C3000 button is available in the
C3000 Inbox view.

1. Select the voice message and click the C3000 button. The Play voice
message menu appears.
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Note You can also open this menu via Actions -C3000 - Play
voice message.

2. Click Play voice message.
A window appears.

3. Enter the telephone number to which you want to forward the voice mes-
sage for playback.

The default entry is the number entered in the C3000 Lotus Notes Client
Setup.

4. Click OK.

The voice message is diverted to the telephone entered where it can
then be listened to.

Note If the Line busy [No Line available!] error occurs, it may be
due to one of the following reasons:

« The application cannot be initialized by the C3000 sys-
tem.

* The line is busy.

» The telephone number cannot be reached (non-exis-
tent).

Check your settings and try again a short time later. If the error

persists, contact your administrator.

Wav-to-Phone: Switch backwards and forwards in messages

While you playback a Wav-to-Phone message on the phone you can skip for-
wards and backwards in this message.

1. While the message is being played back, press the [7] on the phone key-
pad.

You then skip to 5 seconds later in the message. .

2.  While the message is being played back, press the [9] on the phone key-
pad.

You then skip to 5 seconds back in the message, i.e. the last 5 seconds
are repeated.

Faxprinter

With the C3000 fax printer you can generate a fax from any print-compatible
application. The document is converted into fax format locally on your compu-
ter.

Sequence:
1. In the application, select the menu File> Print.
2. Select the fax printer as the printer; its name is C3000 Fax.

After successful conversion (=printing) you are prompted for a password
for the Lotus Notes Client.

3. Type in the password and click OK.
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The Notes Printer window appears.

Note If you want to make the fax available as Fax on Demand, acti-

~ vate the FOD checkbox on the bottom left-hand side. Enter
the number from which the fax can be retrieved in the Number
field. Enter the FOD document name in the Subject field.

4. Enter additional cover sheet text in the Overview tab, if you selected
cover sheets in the Options tab.

Note The fax just converted automatically appears in the Attach-
ments area. Click the Add button to add more attachments.
Click the Remove button to remove an attachment.

5. Click on the Recipient tab to address a message.

Note Optionally: If you want to manually enter an address that is not
in your address book, click the Temporary button and type in
the address details manually. Click OK to return to the Recipi-
ent tab.

6. Click the Address Book button.
The Address Book window appears.
Select the required address book in the Address Books area.

Select the required address from the Addresses area. To search for a
specific address, enter the first letters of the surname in the Starts with
field and click on the Find button.

Note If the Search immediately checkbox is activated, the search
begins immediately as soon as an entry is made or changed
in the Starts with field.

You should therefore only activate the checkbox for small
address books, otherwise the search may take a very long
time.

9. Select the address to send the fax to (option: Fax (Private) / Fax
(Office) / Notes abbreviation).

10. Click the To button. If you want to send a copy or blind copy, select the
address(es) to send to and click the relevant buttons.

11. Click the Close button to return to the Recipient tab. Here the selected
addresses are entered in the To, Cc (copy) and Bec (blind copy) areas.

12. Click on the Options tab to select cover sheets and letterhead. You can
also specify the time of sending and prioritize the send job. Activate the
Long addressing checkbox to import cover sheet information from the
address data. If you are not using cover pages, you can deactivate the
Long addressing checkbox; then only the fax number is displayed.
Click on the Overview tab to view the final addressing data.
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13. Click the Send button to send the message to the selected addresses.

Bypassing password input

To bypass the password prompt:

1. In the Lotus Notes Client click on File > Extras - UserID.
The User ID window appears.

2. Inityou can tick a checkbox to specify whether other Notes-based pro-
grams prompt for a password.

C3000 fax printer

The settings in User mode show the C3000 Option entry only.

More printer configuration options can be set by accessing the printer via the
operating system's Control Panel.

Note As a user, you can read the following configuration options but
cannot change them.

Complete the following steps:

1. Select Start = Printers and Faxes.

2. Right-click on the printer C3000 Fax Printer and click on Properties.
The C3000 Fax Printer Properties window appears.

3. Click the Device Settings tab.

Note Changes to the following settings are usually only by your sys-
tem administrator.

Select PDF in the field File Format.

Use the standard default in the field Temp Directory. The system admi-
nistrator can change the path if necessary.

Select Lotus Notes from the field UM Option.
Select Mail client from the field Connect to.

Click OK to save the settings.
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C3000 mail merge function

In the mail merge function, addressing takes place not in the Notes form, but
in the form letter itself. An identifier (command line) is inserted as the last line
and contains the type of service, address and send options.

These fields can be parameterised in the application as a form letter. The job
is printed in the background, with no further input prompts or actions in Lotus
Notes itself.

Before we explain this procedure using the example of MS Word, check the
configuration of the C3000 mail merge function.

Complete the following steps:

1.

ok~ w D

Click on Start >Execute.

The Execute window appears.

Enter the following command in the Open field: c3ksbmail.
Click on Form Letter>Configuration.

Check whether Lotus Notes is selected as the mail system to be used in
the window that appears.

In the Settings area, activate the checkbox to display the C3000 Notes
domain before printing. Deactivate the checkbox if you do not want this.

Select the required option in the Automatically quit send status area.

Here you can decide whether to view the jobs created at the end of the
print operation. This is of particular interest if errors have occurred.
Select whether the send status is to be displayed always (do not quit
option), only in the event of errors (if OK option) or never (always
option).

If you have activated the Display C3000 Notes domain before printing
checkbox, a window appears in which you can enter the C3000 domain.

You can change the domain here if you want.
Click Send.

Depending on which option you chose for displaying the send status, you
will see a send status report.

Example:

Job No 1 to "Temp@8120362#C3000##H###FAX3@FAX’
Job created.

Job No 2to "Temp@8122362#C3000#####FAX3@FAX’
Job created.

Job No 3to’Temp@8120362#C3000###H##FAX3@FAX’
Job created.

Job No 4to’Temp@8120322#C3000###H##FAX3@FAX’

Job created.

Send jobs containing errors are flagged accordingly.
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Identifier

Note The send status only indicates whether a send job was able

to be created for each address. Lotus Notes notifies success-
ful (failed) transmission of each job individually (return
receipt).

10. Click OK.

C3000 mail merge, example: MS Word3000

This function is explained using the example of creating form letters with MS
Word, although you can do this in a similar way with any other text processing
program.

Define an ordinary form letter in MS Word. The data source, i.e. the address
origin, may be a Word data source or any other data source accepted by Word
for form letters (e.g. an Excel worksheet).

The important thing is that the data source must include a field for the respec-
tive fax number of the addressee. You can name this field whatever you like.
In the following example we use the field name C3000Fax.

When creating the text, insert an instruction (identifier) at the end (!) of the text,
on a separate line (!), with the following general syntax:

(C3#Service:PARAMETER;Variablel :PARAMETER; VariableX:PARAMETER; ... #C3)

An identifier always begins with (C3# and ends with #C3). The various com-
mands are embedded between the two identifiers. The identifier contains a
service and 0..n variables. The order is irrelevant.

An error is displayed if an identifier contains several services or unknown ser-
vices / variables. The document containing the error is not sent.
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Example

Word form letter

Notations

Note

The last command is not followed by a semicolon, but is
directly followed by the terminating identifier #C3).
Position the identifier at the end of the document. The
identifier is hidden when the document is imported into
the fax. The document's formatting is retained.

A conceivable, simply structured command to send a text to fax number

(040)223344 is:

(C3#FX3:040223344#C3)

Note

The overall identifier may not extend beyond more than
one line. If you use several variables in the identifier, you
can minimize the font size so as not to exceed the line.

The layout within an identifier must remain consistent,
i.e. the font, font size and style may not be changed. The
identifiers C3# and #C3 must be written with an upper-
case C.

If variables are contradictory, the error is displayed and
the job is aborted.

The identifier is limited to 500 characters in the printer
driver.

For Lotus Notes only: In Lotus Notes, parts of the identi-
fier are imported into the Notes address.

For Outlook only: In Outlook parts of the identifier are
transferred into the subject line, limited to 256 charac-
ters.

If you insert such a command in a form letter, instead of inserting the fax num-
ber manually you use the data source field:

Examples of identifiers for Word form letters:

(C3#FAX3:<<C3000Fax>>#C3)

or

(C3#<<Service>>:<<Address>>#C3)

If you are using multiple variables, e.g. to specify the time of sending too,
separate each of these variables with a semicolon:

(C3#<<Service>>:<<Address>>;TIME:22:30:00#C3

Different notations for variables and parameters
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There are long and short forms for commands and their parameters, and occa-
sionally abbreviations are also used. For example, instead of entering HIGH
as the priority you can use the abbreviation H. Use the long form wherever
possible, as it will be easier to associate later. The short forms are useful if you
want to use a large number of variables and so would otherwise exceed the

line limit.
Services table
Service (short form)

FAX3 FX3
F3

SMS
SMTP
SAP
FSI

ARCHIVE

Variables table

Variable Variable (short form)

NAME

COMPANY

COMPANY2

COMPANY3

Parameter

<Number>

<Number>
<E-Mail-address>
<SAP-address>
<Address>

<Address>

Parameter

<Name of the addres-
see> e.g.
NAME:Meier.Hugo
(-Hugo ist optional)

<Company name>

>Company add-on>

>Company add-on>

Meaning

FAX Group 3 Send job

SMS send job
Internet Mail send job
SAP send job

FSI send job

Archive send job

Meaning

Insert additional infor-
mation in external
send jobs (cover
sheets)

Insert additional infor-
mation in external
send jobs (cover
sheets)

Insert additional infor-
mation in external
send jobs (cover
sheets)

Insert additional infor-
mation in external
send jobs (cover
sheets)
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Variable

ZIP

CITY

STREET

TIME

DATE

PRIORITY

COVERPAGE

PAPER

PAPER2

ACCOUNT

FILE

Variable (short form)

PRIO

COVER
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Parameter

<Postcode>

<Town/city>

<Street>

HH:MM:SS

Hours:Minutes:Seconds]

JJJJ.MM.DD
[Year.Month.Day]

LOW

L
NORMAL
N

HIGH

H

<Cover sheet abbrevi-
ation>

<Letterhead abbrevia-
tion>

<Letterhead abbrevia-
tion>

<Cost centre>

e.g. V4711

(up to 15 characters)
Complete path and file
name. Several files are

each separated by a
comma.

Meaning

Insert additional infor-
mation in external
send jobs (cover
sheets)

Insert additional
information in external
send jobs (cover
sheets

Insert additional
information in external
send jobs (cover
sheets)

Send time

Send date

Priority of send job:
Top priority jobs are
processed first

Cover sheet

Letterhead

Additional pages
Letterhead
Transfer costs for cost

centre into statistics
program ...

Attach files to
document
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OCR (automatic text recognition)

OCR

=Optical Character Recognition

The OCR service is used to convert text documents in graphical format (e.g.
faxes) into editable text documents.

OCR can be used to automatically convert incoming fax messages. You then
receive a message with the original fax as in TIF file format plus the converted
version in RTF format. Your system administrator uses routing rules to set up
automatic conversion of incoming faxes for you.

As a user, you can also send faxes from your inbox to yourself manually via
the OCR service. You then receive the converted documents in RTF (Rich
Text Format) format in your inbox. This facility is described in this section.

Note You can only use OCR to send documents to yourself. You
cannot send them to other addresses.

Two possible ways of sending faxes are described in the following:

* You can attach a fax document, available in any directory, to a message
as an attachment and send this fax to yourself using the OCR service.

* You can use the OCR service to forward a fax document in your inbox to
yourself as a message.

Sending a fax as an attachment with OCR

Complete the following steps:

1. In the Lotus Notes Mail view, click on the Create >C3000 Message
menu.

The C3000 send form appears.

Click on the C3000 Temp number button.

The C3000 Temp number window appears.
Select the OCR entry in the Service selection field.
Enter OCR in the Fax number or Address field.

2

Note The system ignores this entry. You automatically receive the

converted (RTF) file in your inbox again.
Click OK.
You are returned to the C3000 send form.
Enter a subject.

10. In the attachment, enter the file (e.g. fax) to be converted into an RTF file
using OCR.

11. Send the message.

OCR converts the attachment into an RTF file and places it in your inbox.

Forwarding a fax with OCR

Complete the following steps:
1. Select the required fax in the Lotus Notes Mail view.

C3000 User Manual Lotus Notes — 18-11-2008 — Rel. 1.7 SP2 32



Using C3000 for Lotus Notes

2. Click the Forward button.
3. A message window appears.

4. In the To: field, enter an address that ends with @ocr, e.g. ocr@ocr.

Note The system ignores the part of the address before @ocr, and
so it can be anything you wish. You automatically receive the
converted (RTF) file in your inbox again.

5. Send the fax.
OCR converts the fax into an RTF file and places it in your inbox.
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Fax-on-demand

Complete the following steps to make documents available for requesting from
the fax-on-demand service in C3000:

1.

In the Lotus Notes Mail view, click on the Create > C3000 Message
menu.

The C3000 send form appears.

2. Click on the C3000 Temp number button.
The C3000 Temp number window appears.
3. Select the FOD entry in the Service selection field.
In the Fax number or Address field, enter the number (extension) from
which the document can subsequently be requested as a fax.
5. Click OK.
You are returned to the C3000 send form.
Enter a text for the document in the Subject field.
In the attachment, enter the file you want to make available for fax the
fax-on-demand service.
Note The fax-on-demand document must be in RTF format.
8. Send the message.

The document is now ready for requesting from the fax-on-demand ser-
vice on the specified number.
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SMTP Transmission with Pegasus Mail

This section describes SMTP transmission using the example of the Pegasus
Mail program. Although you can use any e-mail client.

The functions described in this section may not be available at your worksta-
tion. If they are not, contact your system administrator to have the necessary
privileges assigned.

Installing the e-mail client (Pegasus Mail)

Note Skip this section if an e-mail client (e.g. Pegasus Mail) is
already installed on your computer.

Complete the following steps to install Pegasus Mail:
1. Double-click on the installation (setup) file.

2. Follow the on-screen instructions. Click Next to move from one step to
the next.

3. Specify an installation directory for the Pegasus Mail program and click
Next.

Select other installation options (links, etc.) and click Next.
Click Finish.
Pegasus Mail is installed.

6. When you launch Pegasus Mail for the first time, the Pegasus Mail
Internet Setup Wizard appears to guide you through the configuration
process.

You are asked to enter the following settings:

Field/Option Description
e-mail address Enter your e-mail address.
Example:

John.Smith@company.com

POP3 server address Enter the name of the POP3 server.
This name does not usually contain
the '@' symbol.

A POP3 server is a computer on
which new messages are stored for
you until you retrieve them.

You can obtain the name of the
POP3 server from your system
administrator.
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Field/Option

User name

Password

SMTP server address

Internet access methods

Dialup/Network option

Description

Enter a user name. This is the name
by which you download messages
from the POP3 server.

Your input is case-sensitive.

Enter a password.

Your input is case-sensitive.

Enter the name of the SMTP server.
This name does not usually contain
the '@' symbol.

An SMTP server is a computer
which transmits your emails directly
to their recipients.

You can usually enter the name of
the POP3 server here.

You can obtain the name of the
SMTP server from your system
administrator.

If your computer has a permanent
connection to the Internet via a net-
work, select Network.

If you are not sure, ask your system
administrator.

Setting up the e-mail client (Pegasus Mail)

If the Pegasus Mail program is already installed on your computer but your
system administrator has not yet configured Pegasus Mail for SMTP trans-

mission, you can do it yourself.

Complete the following steps:

1. Start Pegasus Mail and select the following menu File=> Network Confi-

guration.

The Internet Mail Settings window appears.

You can obtain your e-mail address, and the names of the POP3 and
SMTP servers from your system administrator.

2. Click on the General tab and click the Start Setup Wizard button. Follow

the on-screen instructions.

Alternatively, you can type the required data directly on the tabs described in

the following table:
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Tab Description
General + Change Internet e-mail
address.

* Click on the Start Setup
Wizard button. Follow the on-
screen instructions. See table
in the "Installing e-mail client
(Pegasus Mail)" chapter on

Page 36.
Receive (POP3) * Add, edit, remove POP3 server
Send (SMTP) * Add, edit, remove SMTP ser-
ver
Dialup Leave the default settings.
Note For more information on configuration refer to the Pegasus

Mail Online Help.

Sending a message via SMTP

You can send and receive the following message types using any e-mail client,
such as Pegasus Mail in the example given here:

«  FAX

« SMS

* Voice message
* Internal e-mail
» External e-mail

Note To be able to handle these message types, the e-mail client

T mustfulfil certain requirements (RFC 3191). Ask your system
administrator whether your e-mail client fulfils these require-
ments.

The following table shows you how to enter the individual message types in
the standard e-mail window in the To: field.Examples are provided in each
case by way of explanation.

<Number>: Enter an international (phone) number here. The following charac-
ters are allowed: "+" prefix, digits and as separators:

" "-"and "/". Start an internal (phone) number with the letter "i".

Example of an internal number:; i814123

Example of an external number:; +49163123456789

<Domain>.<suffix>: Enter the addressee's domain and suffix here. Both must
be known on your network. Ask your system administrator.
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Message typ
FAX

SMS

Voice message
Internal e-mail

External e-mail

Example - internal: verbero.tco

Example - external: company.com

Addressing in the To: field
fax=<number>@<domain>.<suffix>
sms=<number>@<domain>.<suffix>
voice=<nummer>@<domain>.<suffix>
Internal e-mail address

External e-mail address

Example

fax=i814123@verbero.tco
sms=+49163123456789@verbero.tco
voice=i814321@verbero.tco
John.Smith@verbero.tco

John.Smith@company.com
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C3000 Network Printer

This topic describes how you can use the C3000 network printer to send
documents as a fax or SMTP to send them as an e-mail.

Set up and send

You can use the C3000 Network Printer to send a fax or e-mail. You must set
up a C3000 Network Printer first. Ask your system administrator for the name
of the C3000 Network Printer.

Setting up a network printer

Complete the following steps to set up a network printer at your workstation.

1.

© ® N o o

Click Start - Printers and Faxes. The Printers and Faxed dialog box
appears.

Click Add Printer. The Add Printer Wizard dialog box appears.
Click Next. The Local or Network Printer dialog box appears.

Select the option @ A network printer, or a printer attached to
another computer.

Click Next. The Specify a Printer dialog box appears.

Select the option & Connect to the following printer.

Enter the name of the printer or browse for a printer in the directory.
Click Next.

Click Finish. The network printer is set up.
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How do | send a fax?

You can send a fax from any Windows application that can print.
Complete the following steps:

1. Start the Windows application from which you want to send the fax. Enter
your fax text.

2. Enter the fax number and other details directly in the document via codes
codes as described in Kapitel ,Which code can you insert?* auf Seite 41.

3. Save the document.

Print the document. Select the printer. The document is now sent as a
fax to the fax number given by you in the document.

How do | send an e-mail?

You can send an e-mail from any Windows application that can print.
Complete the following steps:

1. Start the Windows application from which you want to send the e-mail.
Enter your email text.

2. Enter the e-mail address and other details directly in the document via
codes codes as described in Kapitel ,Which code can you insert?* auf
Seite 41.

Save the document.

Print the document. Select the printer. The document is now sent as an
e-mail to the e-mail address given by you in the document.
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Codes in the document

Which code can you insert?

Examples of all codes to be directly entered by you in the document are given
in the following:

Codes used in the , in Example in the C3000 Standard profile

the C3000 Standard
profile
To: Fax number FAX %FAX=04532-1234567%
To: E-mail address SMTP %SMTP=karl.muster@company.com%..........
Subject of an e-mail SUBJECT %SUBJECT=This is the subject% .................
Priority PRIORITY %PRIORITY=MEDIUM%
Required send date DATE %DATE=20050307%
Required send time TIME %TIME=103000%
Cost centre for statistics COST_CENTRE %COST_CENTRE=MarketingDepartment%
Fax cover sheet COVER %COVER=FaxTemplate_CoverSheet.doc%
Fax letterhead - 1st page LETTERHEAD1 %STATIONERY 1=FaxTemplate_1stPage.doc
% 56
Fax letterhead (stationery) = LETTERHEAD2 %LETTERHEAD1=FaxTemplate_1stPage.doc
% 56
Digital signature DIGITAL_SIGNATURE %DIGITAL_SIGNATURE=YES%...................
Recommendation

We recommend you enter the codes in the footer of the document to be sent.
The codes are evaluated by the system and replaced with blank spaces. If the
codes are outside the footer and are replaced by blank spaces, this could
change the layout of the original document.

Note The codes must be created in one character set which is the
printer’s standard character set.

For the code key (everything written in the above examples
between “%” and “=”), only letters and “_” are allowed.

The user’s system administrator can change the code types in WebAdmin
(C3000 Network Printer ™ Component @M Profile Administration tab).
The system administrator can also use other characters instead of “%” and “=".

Additional information

Further information is available to your system administrator in the C3000
Administrator Manual in the section “How do I configure the C3000 network
printer in C3000 WebAdmin?”.
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Example

The following text shows an example of a fax message.

Fax message

Firm Street Town/City

Sender's address

Tel: 04532 / 123456
Fax: 04532/123456

Recipient's name

Company name
Street
Town

Town/City, Date
<This is the message text
Yours faithfully

signature

%FAX=123456789%
%COVER=FaxTemplate_CoverSheet.doc%
%LETTERHEAD1=FaxTemplate Letterhead%
%LETTERHEAD2=FaxTemplate_FollowingPages%
%COST_CENTRE=MarketingDepartment%
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